CleanUp For Windows Contents

The Table of Contents lists all Help topics available for CleanUp For Windows. Use the scroll
bar to see the topics not currently visible in the Help window. To learn how to use Help, press
F1 or choose Using Help from the Help menu.
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Overview

CleanUp For Windows allows you to scan one or more disks to identify and remove
unnecessary files, save them to a directory, create (and optionally execute) a batch file, or
print a list of files. CleanUp will identify files with the same name in any directory and display
them in the main window. You can also display a graph of the space used by your largest
directories. Alternatively you can choose to view all files on the disks, zero length files,
backup files (*.BAK), or tagged files. In any view, you can Tag and Untag files for deletion
using any or all of the following criteria:

All Files

Smaller File of each duplicate group

Older File of each duplicate group

Backup Files (*.BAK)

Temporary Files (*.$$%)

All files with a specified extension

All files with zero size

All files with a specified size

All files in a given directory
You can also Tag and Untag files or groups of files with the keyboard or mouse.



Procedures

CleanUp for Windows is normally used to remove duplicate, redundant, and other
unnecessary files from a disk. To do so, use the Scan menu to scan the drive(s). If two or
more files are found with the same name (from different directories or from different drives),
they will be displayed in the window. Use the View menu to choose different sets of files to
be displayed. Tag the files to be deleted using the Tag menu and/or the mouse or keyboard.
(See Tagging Files and UntaggingFiles). Then choose Delete from the Mainmenu.




Main Menu

The following selections are available from the Main menu:
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Action
Duplicates
About
Help
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Scans another disk drive or exits CleanUp

Tags files for deletion

Untags files for deletion

Selects files to be displayed (Duplicates, All, Zero Length or Backup), a
graph of your largest directories, or sets viewing preferences

Allows you to Delete, Store, create a Batch file, or Print the Tagged files
Allows you to change the definition of "duplicate"

Displays the About CleanUp for Windows message

Starts the Windows Help program




Scan Menu

Each drive on your system will appear in the popup menu displayed when the Scan menu is
selected. To select a drive to be scanned, click on the drive letter or press the key
corresponding to the drive letter. CDROM and Network drives will not be included in the
popup menu.

Selecting one of the drives will cause CleanUp to add all of the files on that drive to its list
and note any duplicates. As the drive is scanned, a dialog box will display the progress. Each
drive can be scanned only once.

In addition to the drive letters, the Scan menu has an eXit command.



Tag Menu

The following selections are available from the Tag menu:

All Tags All Files

Smaller Tags the Smaller Files of each duplicate group

Older Tags the Older Files of each duplicate group

Backup Tags Backup Files (*.BAK)

Temp Tags Temporary Files (*.$$$)

Extension Displays an Extension Dialog, into which you can enter a three letter

file extension. All files with that extension will be tagged.

0 Length Tags All files with zero size

Length n Displays a Length Dialog, into which you can enter a file size. All files
with that size will be tagged.

Directory Displays a Directory Dialog, into which you can enter a drive and
directory name. All files in that directory will be tagged.

Visible Controls whether files not in the current view (but which otherwise
meet one of the criteria above) will be tagged also. The default state
restricts tagging to file in the current view, and is indicated by a check
mark to the left. Choosing this item will change the state, but leave the
menu displayed.

For the Smaller and Older selections, if there are more than two files with the same name,
then all but the Largest and Newest will be Tagged.



Untag Menu

The following selections are available from the Untag menu:

All Untags All Files

Smaller Untags the Smaller Files of each duplicate group

Older Untags the Older Files of each duplicate group

Backup Untags Backup Files (*.BAK)

Temp Untags Temporary Files (*.$$$)

Extension Displays an Extension Dialog, into which you can enter a three letter
file extension. All files with that extension will be untagged.

0 Length Untags All files with zero size

Length n Displays a Length dialog, into which you can enter a file size. All files

with that size will be untagged.

Directory Displays a Directory Dialog, into which you can enter a drive and
directory name. All files in that directory will be untagged.

Visible Controls whether files not in the current view (but which otherwise
meet one of the criteria above) will be untagged also. The default state
restricts untagging to file in the current view, and is indicated by a
check mark to the left. Choosing this item will change the state, but
leave the menu displayed.

For the Smaller and Older selections, if there are more than two files with the same name,
then all but the Largest and Newest will be Untagged.



View Menu

The following selections are available from the View menu:

All
Duplicates

Backup
0 Length
Tagged Files

Graph
Preferences

All files will be displayed in the window.

Only files which have the same name as at least one other file
will be displayed in the window.

Only files which have a suffix of .BAK (*.BAK) will be displayed in
the window.

Only files which have a length of 0 will be displayed in the
window.

Only files which are Tagged will be displayed in the window.
Untagging a file in this view will not remove it from the window
until another view is chosen.

Displays a graph of your largest directories.

Displays the Preferences Dialog, which allows you to select the
type of the graph (pie chart, vertical or horizontal bars, or three
dimensional vertical bars). The number of directories in the
graph, the opening screen delay, and the colors can also be set.

By default, only duplicate files are displayed. For each file, CleanUp will show the name,
extension, size, date and time stamp, and drive and directory information. If the file is a
duplicate an asterisk will appear to the left of the file name, and each group of duplicate files
will be displayed in a different color. Files which have been tagged are displayed in reverse

colors.



Action Menu

The following selections are available from the Action menu:

Delete Deletes all Tagged files.

Store Moves all Tagged files to a directory you specify.

Batch Displays the Batch dialog to create a file with the names of all
Tagged files.

Print Allows you to print a list of the files in the current view,

Duplicate files, or All files, or select and configure a printer.



Duplicates Menu
The following selections are available from the Duplicates menu:

Ignore Date & Time
Match Date
Match Date & Time

CleanUp normally considers two files to be duplicates if their names and extensions match
exactly. (The drive and directory are always ignored.) By default, the date and time
associated with the files are not taken into account for this purpose. This menu allows you
change that to require that both the date and time must match, that the date must match,
or (the default) that neither must match. The current choice is shown with a check mark to
the left. If you change that selection, all files will be reevaluated to see if they now (or still)
meet the new definition of "duplicate".



Delete Command

Selecting the Delete Command will start the process of deleting the tagged files. (Tagged
files are displayed in reverse colors - if no files have been tagged, a dialog box will note
that). Before deleting the files, a dialog box with the number of files and total size to be
released will be displayed to confirm the deletion. As the deletion process proceeds, a dialog
box will display the progress.

If a file has been modified since the disk was scanned, the file will not be deleted.



Store Command

Selecting the Store command will move all of the tagged files into a directory (which you
specify in a dialog box). The attributes, date and time of the file are preserved across the
move, but the Archive flag is forced on so that your disk backup program will see these have
having been moved. If moving a file would overwrite another file, the Overwrite Dialog will
be displayed, allowing you to choose which file to keep, or leave both files in their original
locations.




Batch Command

Selecting the Batch command will cause the Batch Dialog to be displayed. This allows you to
create a file containing a line for each Tagged file, with a prefix, suffix, spaces around the
name and other options. The created file can be processed immediately or saved for future
use.



Print Menu

The following selections are available from the Print menu:

Current View
Duplicates
All

Select Printer

The first three choices will print a list of the files in the current view, Duplicate, or All files.
The listing will have all the information displayed on the screen, but will be printed only in
black and white. Duplicate files will have a box drawn around each group.

If you do not have a default printer defined for your system, or if you choose Select Printer, a
dialog box with all defined printers will be displayed. After selecting a printer, you may use
the Setup button in that dialog to change the configuration and parameters for that printer.



Graphs

Selecting the Graph option from the View menu will display a graph of the largest directories
found on all of the disks which have been scanned. Four types of graphs are available:

Pie Chart Each directory appears as a "slice" of a "pie". The pie represents
the space used by all of the directories shown; the size of each
slice is proportional to the space used by that directory.

3 D Vertical Bars Each directory is shown as a three dimensional bar.
Vertical Bars Each directory is shown as a vertical bar.
Horizontal Bars Each directory is shown as a horizontal bar.

For all the bar graphs, each bar is scaled to be proportional to the size of the largest
directory.

The type of the graph and the number of directories shown in the graph can be set from the
Preferences selection in the View menu.



Button Bar
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The Button Bar displayed above allows quick access to several options normally accessed
through the menus.
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Begins a scan of drive C:
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Begins scans of all hard drives on your system
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Tag .BAK

Tags all files with the extension .BAK

v

Tag . 77%

Tags all files with an extension you specify

v

Tagd
Tags all files with zero length

Prunc

Tags all files in a specific directory

Delete

Deletes tagged files

cla
Toggles extended selection mode

Graph

Displays a graph of your largest directories
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Help

Starts the Windows Help program






CUA Mode

CleanUp for Windows complies with the standard Common User Architecture (CUA) Windows
keyboard handling. Tagging multiple files is usually much easier in the extended selection
mode (the default). In this mode, you can tag or untag a file simply by pressing the space
bar or clicking on it with the mouse, and your other selections will not be affected. You can
change between extended selection and standard modes at any time by clicking on the CUA
button or pressing SHIFT + F8.



Keys

Use the following keys in CleanUp For Windows:
Key: Function:
Ctri+Slash (/) Tags all files.
Ctrl+Backslash (\)  Untags all files.

The following navigational keys move the selection cursor:

Key: Function:

Up Arrow Up one line.

Down Arrow Down one line.

PgUp Up one window.

PgDn Down one window.

Home First file in the first window.

End Last file in the last window.

Letter key Next file whose name begins with the specified letter.

When CUA Mode is selected, moving the selection cursor will Tag the file at the new position
and Untag all other files.

Related Topics:

Tagging Files
Untagging Files




Tagging Files

To Tag:
A Single File

A Group of Files

All Files

Related Topics:
Untagging Files

Do this:

Hold down Ctrl and click the file. Or use the navigational keys to move
to the file and press Space. If you are not in extended selection mode,
click the CUA button on the button bar or press SHIFT + F8 before
using the navigational keys or any previously tagged files will be
untagged.

Hold down Ctrl and click the first (or last) file in the group. While
holding the mouse button down, move the mouse to the last (or first)
file in the group. Or use the navigational keys to move to the first (or
last) file in the group, press Space. While holding Shift, use the
navigational keys to move to the last (or first) file in the group. If you
are not in extended selection mode, click the CUA button on the button
bar or press SHIFT + F8 before using the navigational keys or any
previously tagged files will be untagged.

Choose Tag All from the Tag menu.




Untagging Files

To Untag:
A Single File

A Group of Files

All Files

Related Topics:
Tagging Files

Do this:

Hold down Ctrl and click the file. Or use the navigational keys to move
to the file and press Space. If you are not in extended selection mode,
click the CUA button on the button bar or press SHIFT + F8 before
using the navigational keys or any previously tagged files will be
untagged.

Hold down Ctrl and click the first (or last) file in the group. While
holding the mouse button down, move the mouse to the last (or first)
file in the group. Or use the navigational keys to move to the first (or
last) file in the group and press Space. While holding Shift, use the
navigational keys to move to the last (or first) file in the group. If you
are not in extended selection mode, click the CUA button on the button
bar or press SHIFT + F8 before using the navigational keys or any
previously tagged files will be untagged.

Choose Untag All from the Untag menu.




Current View

The set of files displayed in the main window. May be All, Duplicate, Backup, 0 length, or
Tagged. A graph is also considered to be a possible View.



Directory Dialog

= Select Directory

Directorny: | ch |

Options [ Include subdirectories Cancel

- Tag
O Untag
o Delete

The Directory Dialog is displayed when you choose Directory... from the Tag or Untag menu

or click on the Prune button. Fun: © You may enter any directory name - a drive letter is
required. The radio buttons in the Options group allow you to choose whether you wish to
Tag, Untag, or Delete the files in that directory. If you choose Delete, the Remove
directories checkbox will be enabled and checking that will remove any empty directories
resulting from the file deletions. The Include subdirectories checkbox may be checked to
include subdirectories of the specified directory in the operation.



Batch Dialog

= Create Batch File

Add Before Hame: Add After Mame:

L] Full Path [] Spaces around name [] PAUSE after each £1¥

File Hame
—

Example Cancel
[ cleanup_bak

The Batch Dialog is displayed when you choose Batch... from the Action menu.

Enter text in the Add Before Name and Add After Name edit controls that will be used as
a prefix and suffix to each file name.

Check Spaces around name when adding text before or after the name if appropriate.
Check Full Path to include the drive and path information as well as the file name.

Check PAUSE after each to alternate command lines with PAUSE statements.

The Example box will show you exactly how each line in the batch file will look as you enter
text and change the options.

Use the File Name button to display a dialog to specify the file name to be used. If you do
not need to save the file, but simply want to invoke in immediately, press the Execute
button. The OK button will not be enabled unless you specify a file name - after that you can
press OK to create the file.



Overwrite Dialog

= Archiving Files

WARMNING: A file already exists in

> : il 2
the archive directory. Overwrite it? =

Source: c:\autoexec.bat
10/03/93 01:23:44p 1.278 Cancel

Destination: c:\savedirtautoexec_bat Yes to All
10/15/93 05:13:20a 2.456

The Overwrite Dialog is displayed when you choose the Save option from the Action menu,
and one of the files being Saved (the Source) has the same name as one of the files in the
Destination directory. For each file, CleanUp shows the date, time, and size.

Press the Yes button to overwrite the Destination file.

Press the No button to leave the Source file in its original location.

Press the Cancel button to stop the Save processing.

Press the Yes to All button to overwrite the Destination file. If CleanUp finds any other
overwrite conditions during the Save process, it will not display this dialog again and will
overwrite the Destination files.

Press the No to All button to leave the Source file in its original location. If CleanUp finds
any other overwrite conditions during the Save process, it will not display this dialog again
and will leave the Source files in their original locations.



Preferences Dialog

= Preferences

[ Graph Stple — ] " Colors
® Pie Chart
i 3 D Vertical Bars
o Yertical Bars
O Hornzontal Bars

Directories Dizplayed:

Splazh Screen Delay: EI

The Preferences Dialog is displayed when you choose the Preferences option from the View
menu.

The Graph Style group box contains four radio buttons which control the type of a graph
that will be displayed when you choose the Graph option from the View menu:

ie Chart Horizontal Bars

[ [)

3 D Vertical Bars I""' e Vertical Bars

The Directories Displayed control determines how many directories will be displayed
when the Graph option is in effect.

The Splash Screen Delay control determines the number of seconds the greeting screen
will be displayed when CleanUp is started.

The Colors group box contains 16 checkboxes - one for each possible color to be used in the



graph and for highlighting duplicate groups of files. Two of these (the ones for the default
window text and window background colors, as set with the Control Panel Colors utility) will
be initially gray and will not be used. Checking or unchecking any of the other checkboxes
will enable or disable that particular color. At least one checkbox must be checked or
CleanUp will use all colors.



Navigational Keys

The following navigational keys move the selection cursor:

Key: Function:

Up Arrow Up one line.

Down Arrow Down one line.

PgUp Up one window.

PgDn Down one window.

Home First file in the first window.
End Last file in the last window.

Letter key Next file whose name begins with the specified letter.



